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CHƯƠNG 1: PHOTOSHOP VÀ LỢI ÍCH CỦA KHÓA HỌC PHOTOSHOP 

A. Mục đich nghiên cứu 

 
B. Nội dung bài học 

 

I. Photoshop là gì? 

Adobe Photoshop là một phần mềm chỉnh sửa ảnh chuyên nghiệp được phát triển bởi hãng 

phần mềm Adobe Systems. Được ra mắt lần đầu tiên vào năm 1988, Photoshop nhanh chóng trở 

thành một trong những công cụ chỉnh sửa ảnh hàng đầu trên thị trường. Nó cung cấp nhiều tính 

năng mạnh mẽ cho việc biên tập, tạo đồ họa, và xử lý hình ảnh, từ các công cụ cơ bản như cắt, 

dán, đến các tính năng cao cấp như layers, mask, và các hiệu ứng đặc biệt. Photoshop là công cụ 

quan trọng trong ngành thiết kế đồ họa, nhiếp ảnh và nhiều lĩnh vực khác. 

II. Photoshop làm được những gì? 

Adobe Photoshop có rất nhiều ứng dụng quan trọng trong nhiều lĩnh vực khác nhau. Dưới đây 

là một số ứng dụng chính của Photoshop: 

1. Nhiếp ảnh và Đồ họa: Photoshop là công cụ quan trọng cho các nhiếp ảnh gia và những người 

làm đồ họa để chỉnh sửa và cải thiện hình ảnh, tạo ra đồ họa chất lượng cao. 

2. Thiết kế Đồ họa và Quảng cáo: Sử dụng để tạo các thiết kế đồ họa, banner, poster, và các nội 

dung quảng cáo sáng tạo. 

3. Thiết kế Đồ họa Web: Photoshop hỗ trợ trong việc tạo ra các giao diện web đẹp mắt, các hình 

ảnh nền và biểu tượng cho trang web. 

4. Thiết kế UX/UI: Cho phép thiết kế các giao diện người dùng (UI) và trải nghiệm người dùng 

(UX) cho ứng dụng và trang web. 

5. In ấn và Định dạng: Sử dụng để chuẩn bị các file in ấn chất lượng cao, bao gồm cả thiết kế sách, 

brochure, và các vật liệu quảng cáo khác. 

6. Nghệ thuật số hóa hình ảnh cổ điển: Chuyển đổi các hình ảnh cổ điển thành bản số, phục hồi và 

tái tạo hình ảnh cũ. 

7. Chỉnh sửa Video và Ảnh Động: Ngoài chỉnh sửa ảnh, Photoshop cũng hỗ trợ chỉnh sửa video 

và ảnh động, với khả năng thêm các hiệu ứng và đồ họa chất lượng cao. 

8. Đồ họa 3D: Tạo và chỉnh sửa đối tượng 3D, cung cấp tính năng mạnh mẽ cho các nghệ sĩ đồ 

họa 3D. 

9. Tạo và Chỉnh sửa nội dung Đa phương tiện: Tạo và chỉnh sửa các nội dung đa phương tiện như 

ảnh, video và âm thanh để sử dụng trên nhiều nền tảng truyền thông. 

• Nắm được định nghĩa, khái niệm, chức năng của photoshop và khóa 

học photoshop tại tin học Sao Việt 

• Nắm được khái niệm về hình ảnh, định dạng ảnh và các chế độ màu 

 

• Photoshop là gì? 

• Photoshop làm được những gì? 

• Lợi ích của khóa học Photoshop tại Tin học Sao Việt 

• Tìm hiểu về ảnh kỹ thuật số 

• Những khái niệm cần nắm trước khi học đồ họa 
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Photoshop có sức mạnh linh hoạt và đa dạng, là công cụ không thể thiếu cho nhiều ngành nghề 

sáng tạo và công việc liên quan đến xử lý ảnh và đồ họa. 

III. Lợi ích của khóa học Photoshop tại Tin học Sao Việt 

Khóa học Photoshop tại Tin học Sao Việt mang lại nhiều lợi ích cho học viên, dưới đây là một 

số điểm nổi bật: 

1. Học từ Giảng viên Chuyên nghiệp: Tin học Sao Việt có đội ngũ giảng viên giàu kinh nghiệm, 

chuyên sâu trong lĩnh vực Photoshop, giúp học viên nắm vững kiến thức và kỹ năng từ những 

người có kinh nghiệm thực tế. 

2. Chương trình học linh hoạt: Khóa học được thiết kế linh hoạt, phù hợp với cả người mới bắt 

đầu và những người đã có kinh nghiệm. Học viên có cơ hội lựa chọn các bài giảng phù hợp với 

nhu cầu và trình độ của mình. 

3. Thực hành trên các dự án thực tế: Tin học Sao Việt đặt trọng tâm lớn vào việc thực hành trên 

các dự án thực tế, giúp học viên áp dụng kiến thức đã học vào các tình huống thực tế và phát triển 

kỹ năng sử dụng Photoshop một cách hiệu quả. 

4. Tài nguyên phong phú: Học viên sẽ được cung cấp các tài liệu học phong phú, bao gồm video 

hướng dẫn, tài liệu tham khảo, và bài kiểm tra để hỗ trợ quá trình học tập. 

5. Hỗ trợ học viên: Hỗ trợ chăm sóc học viên trong suốt quá trình học, giúp giải đáp thắc mắc, 

cung cấp hỗ trợ kỹ thuật và khuyến khích tương tác giữa học viên và giảng viên. 

6. Chứng chỉ hoàn thành: Sau khi hoàn thành khóa học, học viên sẽ nhận được chứng chỉ có giá 

trị, chứng minh khả năng sử dụng thành thạo Photoshop, điều này có thể là một điểm mạnh khi 

xin việc trong lĩnh vực thiết kế đồ họa và nhiếp ảnh. 

7. Cập nhật nhanh chóng với công nghệ mới: Tin học Sao Việt cam kết cập nhật nhanh chóng với 

các công nghệ mới và xu hướng trong lĩnh vực Photoshop, giúp học viên luôn có những kiến thức 

mới nhất và sáng tạo. 

Những lợi ích trên giúp học viên nắm bắt kiến thức và kỹ năng cần thiết để sử dụng Adobe 

Photoshop một cách linh hoạt và chuyên nghiệp. 

IV. Tìm hiểu về ảnh kỹ thuật số 

1. Ảnh kỹ thuật số là gì? 

Ảnh kỹ thuật số là hình ảnh được biểu diễn và lưu trữ dưới dạng dữ liệu số hóa. Điều này có 

nghĩa là hình ảnh không được ghi lại bằng phương tiện truyền thống như phim, mà thay vào đó, 

dữ liệu từ cảm biến hình ảnh được chuyển đổi thành dãy số và lưu trữ trong các tệp tin số hóa. 

2. Đặc điểm chính của ảnh kỹ thuật số 

Các đặc điểm chính của ảnh kỹ thuật số bao gồm: 

Dạng Dữ Liệu Số (Digital Data): 

Ảnh kỹ thuật số được biểu diễn dưới dạng dữ liệu số, thường là các giá trị số nguyên hoặc số thực 

đại diện cho mỗi pixel trong ảnh. 

Độ Phân Giải (Resolution): 

Độ phân giải của ảnh kỹ thuật số xác định mức độ chi tiết và sắc nét của hình ảnh. Nó được đo 

bằng số lượng pixel trên chiều rộng và chiều cao của ảnh. 

Màu Sắc (Color): 
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Các ảnh kỹ thuật số có thể là ảnh đen trắng (grayscale) hoặc ảnh màu. Mỗi pixel có thể chứa thông 

tin về một hoặc nhiều kênh màu, thường là RGB (Red, Green, Blue). 

Kích Thước Tệp Tin: 

Kích thước của tệp tin ảnh kỹ thuật số thường phụ thuộc vào độ phân giải và định dạng lưu trữ, 

chẳng hạn như JPEG, PNG, TIFF, hay RAW. 

Chỉnh Sửa Linh Hoạt: 

Ảnh kỹ thuật số có thể dễ dàng được chỉnh sửa và xử lý bằng các phần mềm chỉnh sửa ảnh, cung 

cấp sự linh hoạt lớn trong việc điều chỉnh màu sắc, độ tương phản, và các yếu tố khác của hình 

ảnh. 

Dung Lượng Pixel: 

Mỗi pixel trong ảnh kỹ thuật số có độ sâu bit định nghĩa dung lượng pixel, ảnh 8-bit mỗi kênh là 

phổ biến, nhưng cũng có các định dạng 16-bit hoặc 32-bit cho độ chính xác cao hơn. 

Ảnh kỹ thuật số đã thay thế nhiếp ảnh truyền thống và mang lại nhiều lợi ích như khả năng xử lý 

dễ dàng, chia sẻ nhanh chóng trên mạng, và khả năng lưu trữ linh hoạt. 

V. Những khái niệm cần nắm trước khi học đồ họa 

1. Khái niệm ảnh Raster và ảnh Vector: 

 Ảnh Raster Ảnh Vector 

Khái niệm 

Ảnh raster, hay còn được gọi là ảnh 

bitmap, là loại ảnh được tạo ra từ 

một tập hợp các điểm ảnh (pixel) có 

màu sắc và thông tin chi tiết. 

Ảnh vector sử dụng các đối tượng hình 

học như điểm, đường, hình vuông để 

biểu diễn hình ảnh. Thay vì dựa vào 

pixel, nó sử dụng các công thức toán học 

để xác định hình dạng. 

Đặc điểm 

Ảnh raster thường có độ phân giải 

cố định và khi bạn phóng to nó, bạn 

có thể thấy các pixel làm mất chất 

lượng hình ảnh. 

Ảnh vector có thể phóng to mà không 

làm mất chất lượng, vì nó không dựa vào 

pixel. Nó giữ được tính linh hoạt và độ 

sắc nét ngay cả khi thay đổi kích thước. 

Định dạng 

thường dùng 

JPEG, GIF, PNG, TIFF, RAW, PSD SVG, PDF, EPS, AI 

Sử dụng 

Thích hợp cho hình ảnh chứa nhiều 

chi tiết, gradient màu sắc, và ảnh 

chụp từ máy ảnh. 

Thích hợp cho biểu đồ, biểu tượng, logo, 

vì chúng có thể được điều chỉnh kích 

thước mà không làm mất độ sắc nét. 

Kết luận 

Tóm lại, ảnh raster chủ yếu tập trung vào pixel và thích hợp cho hình ảnh có 

nhiều chi tiết, trong khi ảnh vector sử dụng các đối tượng hình học và linh hoạt 

khi thay đổi kích thước, thích hợp cho các đối tượng đồ họa đơn giản và linh 

hoạt. 

2. Tìm hiểu một số định dạng ảnh thường dùng: 

Định dạng ảnh Ưu điểm Sử dụng 

JPEG 
Kích thước file nhỏ, hỗ trợ màu 

sắc phong phú. 

Chủ yếu cho hình ảnh chụp từ máy ảnh, 

hình ảnh nghệ thuật, và ảnh trên web. 

PNG 
Hỗ trợ nền trong suốt, không mất 

chất lượng khi lưu ảnh. 

Phù hợp cho biểu đồ, hình ảnh với nền 

trong suốt, logo, và ảnh web. 
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GIF 
Hỗ trợ animation, kích thước file 

nhỏ. 

Cho hình ảnh động nhỏ, biểu tượng, và 

hình ảnh đơn giản. 

TIFF 
Hỗ trợ nén không mất chất lượng, 

hỗ trợ ảnh không nén. 

Thường được sử dụng trong in ấn, xuất 

bản, và làm việc chuyên nghiệp. 

BMP 
Chất lượng hình ảnh tốt. Thường được sử dụng trong các ứng 

dụng Windows và trong thiết kế đồ họa. 

EPS 
Hỗ trợ vector và bitmap, thích 

hợp cho in ấn và xuất bản. 

Dùng cho đồ họa vector, logo và ảnh in 

ấn. 

SVG 

Dữ liệu hình ảnh dạng vector, có 

thể co giãn mà không mất chất 

lượng. 

Phù hợp cho biểu đồ, biểu tượng, và đối 

tượng đồ họa vector. 

PDF 
Dữ liệu chất lượng cao, giữ định 

dạng và bố cục. 

Đối với tài liệu in ấn, sách điện tử, và 

biểu mẫu. 

PSD 
Dữ liệu lớp và thông tin chỉnh sửa 

của Photoshop. 

Cho việc chỉnh sửa hình ảnh và thiết kế 

đồ họa. 

AI 
Dữ liệu vector, giữ được tính linh 

hoạt khi thay đổi kích thước. 

Đối với đồ họa vector, logo, và thiết kế 

đồ họa. 

3. Các chế độ màu ảnh (color modes) 

Bit Map (Bitmap): 

Mô Tả: Chế độ này biểu diễn ảnh chỉ bằng cách sử dụng các pixel có giá trị đen hoặc trắng, mà 

không có các mức xám trung gian. 

Sử Dụng: Thường được sử dụng trong các trường hợp đặc biệt như in ấn kỹ thuật số hoặc khi cần 

tạo ảnh với dung lượng file nhỏ.  

RGB (Red, Green, Blue): 

Mô Tả: Sử dụng ba màu cơ bản là đỏ, xanh lá cây và xanh dương để tạo ra toàn bộ màu sắc. 

Sử Dụng: Chủ yếu cho hình ảnh hiển thị trên màn hình, như ảnh web và thiết kế đồ họa. 

CMYK (Cyan, Magenta, Yellow, Black): 

Mô Tả: Sử dụng bốn màu cơ bản là cyan, magenta, yellow và black để tạo ra màu sắc, thường 

được sử dụng trong in ấn. 

Sử Dụng: Cho các dự án in ấn, như sách, tờ rơi, và biểu đồ màu. 

Grayscale (Đen Trắng): 

Mô Tả: Biểu diễn hình ảnh chỉ bằng các mức độ đen, trắng và các mức xám ở giữa. 

Sử Dụng: Cho ảnh đen trắng hoặc khi muốn giảm dung lượng file. 
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CHƯƠNG 2: LÀM QUEN VỚI GIAO DIỆN LÀM VIỆC CỦA PHOTOSHOP 

A. Mục đich nghiên cứu 

 
B. Nội dung bài học 

 

I. Khởi tạo dự án thiết kế 

Nhấn chuột trái hai lần liên tiếp vào biểu tượng photoshop trên màn hình làm việc để 

tiến hành khởi động phần mềm. 

Sau khi khởi động phần mềm, giao diện làm việc sẽ được hiển thị như sau:  

1: Khởi tạo dự án mới 

2: Mở dự án / hình ảnh có sẵn 

3: Hiển thị chế độ xem kiểu danh sách 

4: Hiển thị chế độ xem kiểu lưới 

1. Tạo dự án thiết kế mới 

Tại giao diện làm việc sau khi khởi động phần mềm, ta click vào Create new hoặc vào File → New 

• Nắm được cách tạo file, lưu file, mở file 

• Làm quen với giao diện phần mềm và các thao tác cơ bản 

 

• Khởi tạo dự án thiết kế 

• Làm quen với giao diện phần mềm 

• Chế độ xem ảnh 

• Lưu dự án có sẵn 

 

T
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Tại hộp thoại New Document ta cần thiết lập những thông số sau: 

1: Đặt tên cho dự án 

2: Thiết lập độ rộng khổ giấy 

3: Thiết lập chiều cao khổ giấy 

4: Thiết lập đơn vị 

5: Khổ giấy dọc / ngang 

6: Độ phân giải 

7: Chế độ màu của dự án 

8: Chọn màu nền 

9: Create để tiến hành khởi tạo dự án 

 

2. Mở dự án / hình ảnh có sẵn 

Tại giao diện làm việc sau khi khởi động phần mềm, ta click vào Open hoặc vào File → Open 

 

Ta tiến hành chọn dự án / hình ảnh có sẵn tại hộp thoại Open sau đó nhấn Open để tiến hành mở 

dự án / hình ảnh. 

T
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II. Làm quen với giao diện phần mềm 

1. Khu vực hiển thị nội dung của các file mà bạn sẽ xử lý. 

Khi các bạn mở một file hoặc tạo mới 1 file để thao tác thì file đó sẽ hiển thị ở khu vực số 1, bạn 

có thể mở cùng lúc và thao tác với nhiều file. 

2. Thanh menu chính chứa các trình đơn xử lý, cấu hình. 

Thanh này gồm 11 Menu: File, Edit, Image, Layer, Type, Select, Filter, View, 3D, Window, Help. 

3. Thanh công cụ (Toolbox) chứa các công cụ xử lý, thao tác với các file. 

Đây là nơi chứa các công cụ xử lý, thao tác file. Có tới 30 công cụ giúp cho việc sửa chữa, chọn 

lựa và điều chỉnh ảnh. Một số công cụ trong bảng còn có các công cụ ẩn (hidden tools – các công 

cụ có 1 chấm tam giác nhỏ ở dóc dưới phải). Phần này mình sẽ dành riêng 1 bài để giới thiệu về 

các công cụ. 

4. Vùng quản lý các lớp (Layer) của file đang thao tác. 

Bảng Layers giúp ta quản lý các lớp của 1 tấm ảnh. Layer tựa như những tấm phim trong suốt đặt 

chồng lên nền (background) của 1 tấm ảnh. Trên mỗi tấm phim là những hình ảnh, đối tượng được 

đặt vào qua các lần sao chép, cắt dán hoặc tạo mới bằng các công cụ của PTS. 

5. Khu vực thanh tuỳ chỉnh. 

Nó sẽ hiển thị các nút chỉnh tương ứng với công cụ mà bạn lựa chọn trong Toolbox. 

III. Chế độ xem ảnh 

▪ Photoshop cho phép xem hình ảnh từ 0,67% đến 3.200% 

▪ Để phóng to: Ctrl và phím + 

▪ Để thu nhỏ: Ctrl và phím - 

▪ Nhấn Ctrl + Alt và phím số 0, để đưa hình ảnh về tỉ lệ 100%. 

▪ Để xác định chính xác phần hình ảnh mà muốn phóng to hoặc thu nhỏ: Chọn công cụ Zoom 

(+) sau đó đặt trỏ công cụ lên trên phần hình ảnh đó và nhấp chuột; Hoặc Ctrl + SpaceBar và 

rê chuột để phóng to một khu vực. 
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IV. Lưu dự án có sẵn 

Để lưu dự án ta vào File → Save (lưu) hoặc Save As (Lưu mới) 

 

Tiến hành chọn thư mục lưu → nhấn Save để tiến hành lưu 
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CHƯƠNG 3: NHÓM CÔNG CỤ VÙNG CHỌN 

A. Mục đich nghiên cứu 

 
B. Nội dung bài học 

 

I. Bộ công cụ Marquee Tool 

 

Kết hợp giữ phím Shift trên bàn phím: Chọn đều - chọn một vùng chọn hình tròn, hình vuông. 

Kết hợp giữ phím Alt để tạo vùng chọn từ tâm. 

Alt + Shift + Rê chuột: Tạo hình vuông / tròn từ tâm 

Kết quả: một khung viền nhấp nháy. Mọi thao tác xử lý lúc này chỉ có tác dụng bên trong khung 

viền đó.  

  

• Nắm được cách sử dụng các công cụ vùng chọn và hiệu chỉnh vùng 

chọn cơ bản 

• Bộ công cụ Marquee Tool 

• Bộ công cụ Lasso 

• Công cụ Magic wand 

• Công cụ Quick Selection 

• Menu Select (hiệu chỉnh vùng chọn) 
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II. Bộ công cụ Lasso 

 

Lasso: công cụ chọn vùng chọn tự do, khi thao tác ta click giữ và rê chuột sao cho đường viền 

chọn chạy theo chu vi của một đối tượng. Muốn kết thúc thao tác chọn, ta chỉ cần nhả chuột. 

Kết quả: đường viền chọn bao quanh đối tượng theo đường chu vi. 

 

Polygon Lasso: công cụ chọn vùng chọn tự do, khi thao tác ta click từng điểm để tạo khung viền 

chọn. Click lại điểm đầu tiên hoặc kích kép để kết thúc. Xóa từng điểm chọn sai bằng phím 

Backspace hoặc Undo từng bước.  

 

Magnetic Lasso: công cụ Lasso từ tính, khi thao tác với công cụ này thì vùng chọn luôn bám vào 

biên của hình ảnh, thích hợp cho những đối tượng có độ tương phản cao về màu sắc giữa biên đối 

tượng với nền. 

Thao tác thực hiện: Click xác định điểm đầu tiên, nhả chuột, di chuyển chuột dọc biên đối tượng, 

click lại điểm đầu tiên hoặc double click để kết thúc. Trong quá trình di chuyển chuột quanh chu 

T

in Học Sao Việt 093 11 44 858

T

in Học Sao Việt 093 11 44 85 8

T

in Học Sao Việt 093 11 44 85 8

T

in Học Sao Việt 093 11 44 858



Trung Tâm Tin Học Sao Việt   093.11.44.858  tinhocsaoviet.com 

 Đào Huy Hoàng Giáo Trình Photoshop Cơ Bản | Trang 11 

vi đối tượng, ta có thể click để cưỡng chế vùng chọn đi đúng hướng (nếu chế độ tự động không 

chính xác). Xóa từng điểm chọn sai bằng phím Backspace hoặc Undo từng bước.  

III. Công cụ Magic wand 

 

Là công cụ chọn vùng theo vùng màu tương đồng.  

Thao tác thực hiện: Chọn công cụ Magic wand. Kích vào một màu trên hình ảnh, một vùng màu 

tương ứng được chọn. Độ rộng của vùng chọn tùy thuộc vào giá trị Tolerance trên thanh Options.  

 

IV. Công cụ Quick Selection 

 

Là công cụ chọn nhanh một vùng chọn bằng cách kích liên tục vào những vùng hình ảnh cần chọn. 
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V. Menu Select (hiệu chỉnh vùng chọn) 

Select All (Ctrl + A): Tạo vùng chọn bao kín toàn bộ hình 

ảnh.  

Deselect (Ctrl + D): Hủy vùng chọn. 

Reselect (Ctrl + Shift + D): Lấy lại vùng chọn đã hủy. 

Inverse (Ctrl + Shift + I): Nghịch đảo vùng chọn. 

Color Range: Chọn theo màu 

+ Selection: Ô preview chỉ hiển thị hình ảnh dưới 

dạng màu trắng, đen. Vùng có có màu trắng là vùng được 

chọn, vùng màu đen là vùng không được chọn. 

+ Image: Ô preview hiển thị dạng ảnh màu. 

Select and Mask… (Alt + Ctrl + R): Dùng để tinh chỉnh 

đường biên của vùng chọn. 

Modify: Điều chỉnh vùng chọn 

+ Border: Tạo khung biên vùng chọn – Width: Độ 

rộng của biên 

+ Smooth: Bo góc vùng chọn – Sample Radius: Góc 

bo 

+ Expand: Mở rộng đều chu vi vùng chọn 

+ Contract: Thu hẹp đều chu vi vùng chọn 

+ Feather (Shift + F6): Làm mờ biên vùng chọn, tùy 

thuộc vào giá trị Feather Radius. 

Transform Selection: Phóng to, thu nhỏ, xoay,…vùng chọn 

Invert để nghịch đảo vùng chọn. 
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CHƯƠNG 4: LÀM VIỆC VỚI LAYER – TRANSFORM 

A. Mục đich nghiên cứu 

 
B. Nội dung bài học 

 

I. Layer là gì? 

Tập tin hình ảnh trên photoshop bao gồm một hoặc nhiều phần lắp ghép lại. 

Ta có thể sao chép bất kỳ hình ảnh nào trên các tập tin khác vào tập tin hình ảnh của mình theo 

qui tắc chung là xây dựng trên lớp layer. 

Khi tạo mới một tập tin thì mặc định nó là layer Background. 

Các layer khác được xếp chồng lên theo một thứ tự để thể hiện một hình ảnh. 

II. Quản lý Layer 

1. Thao tác quản lý cơ bản 

Opacity: Độ trong suốt (độ mờ đục) của Layer 

Fill: Độ trong suốt của các Pixel màu (không kể màu của 

hiệu ứng LayerStyle). 

Blending Mode (chế độ hòa trộn lớp) 

 

Các chế độ khóa Layer: 

+ Khóa các pixel trong suốt 

+ Khóa không cho hiệu chỉnh trên hình ảnh 

+ Khóa không cho di chuyển 

+ Khóa tất cả mọi tác động lên Layer đó. 

 

Biểu tượng con mắt: Ẩn/ Hiện Layer 

Lớp nền Background (mặc định là không di chuyển được) 

 

Liên kết các Layer được chọn 

Add a Layer Style: Hiệu ứng trên Layer 

• Nắm được khái niệm về layer, quản lý và sử dụng layer 

• Nắm được các chế độ hòa trộn, hiệu ứng trên layer và công cụ biến 

đổi hình 

 

• Layer là gì? 

• Quản lý Layer 

• Các chế độ hòa trộn 

• Transform 

• Layer Style 
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Add a mask: Tạo một lớp mặt nạ mới. 

Create new fill or adjustment Layer: phủ lên đối tượng một lớp màu hay một lớp hiệu chỉnh mới. 

Create a new Group: Tạo một group mới (thư mục chứa các Layer con bên 

trong) 

Tạo một Layer mới 

Xóa Layer, xóa hiệu ứng, xóa mặt nạ,… 

2. Chọn Layer 

Có nhiều cách chọn Layer 

Click mouse trực tiếp lên layer 

Chọn một lúc nhiều layer: Clich chọn 1 layer và nhấn Ctrl sau đó tiếp tục click chọn những layer 

khác 

Chọn đối tượng 1 và giữ Shift sau đó click chọn Layer cuối cùng của nhóm muốn chọn. 

3. Đổi tên và nhân đôi Layer 

Đổi tên layer: 

Double click vào tên layer hiện tại của layer trong palette layer → nhập tên mới 

Nhân đôi Layer: 

Chọn Layer → nhấn Ctrl + J 

Chọn Layer → Chọn công cụ Move → Bấm giữ Alt + kéo chuột 

Kéo layer muốn nhân đôi vào biểu tượng “Create a new Layer” 

4. Lồng ghép các Layer 

Điều kiện: Phải có ít nhất hai Layer 

Đặt Layer hình ảnh nằm trên Layer dùng làm khung 

chứa 

Menu Layer/ Create Clipping Mask (Ctrl + Alt + G) 

Hoặc bấm giữ Alt và kích vào đường ngăn cách giữa 

2 Layer này. 

Gỡ bỏ chế độ lồng ghép Layer: 

Menu Layer/ Release Clipping Mask (Ctrl + Alt + G) 

Hoặc một lần nữa bấm giữ Alt và kích vào đường 

ngăn cách giữa 2 Layer này. 

Ví dụ: Có 2 Layer, Layer text và Layer hình ảnh  

5. Sắp xếp các Layer 

Bring Forward (Ctrl+]): Đưa Layer lên trên một vị trí 

Send Backward (Ctrl+[): Đưa layer xuống dưới một vị trí 

Bring to Front (Ctrl+Shift+]): Đưa Layer lên trên cùng 

Send to Back (Ctrl+Shift+[): Đưa Layer xuống dưới cùng 
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III. Các chế độ hòa trộn 

Normal: Chuẩn, không hòa trộn  

Dissolve: Tạo hiệu ứng cọ vẽ khô trong một lượng Pixel được hòa 

trộn. 

Darken: Kết quả nghiêng về màu tối, sắc độ đậm vẫn được bảo toàn, 

đậm hơn so với ảnh ban đầu. 

Multiply: Kết quả đậm hơn so với ảnh ban đầu và có sự hòa trộn đều 

màu sáng và màu tối. 

Color Burn: Tạo ra hiệu ứng chiếu sáng thường nghiêng về sắc nâu 

đỏ, những màu sáng trở nên rực rỡ, hiệu ứng thường tạo ánh sáng gắt 

trên nền đậm. 

Linear Burn: Hiệu ứng gần giống Color burn nhưng độ chuyển màu 

bớt gắt hơn các độ chuyển sáng tối. 

Lighten: Tạo ra kết quả sáng hơn so với ảnh ban đầu và làm giảm 

độ đậm trên hình ảnh. 

Screen: Sáng hơn so với ảnh ban đầu, chế độ này ngược với hiệu 

ứng Multiply. 

Color Dodge: Làm sáng màu nền để làm nổi bật màu hòa trộn 

thường nghiêng về những màu rực rỡ. 

Linear Dodge: Hiệu ứng gần giống Color Dodge nhưng độ sáng bớt 

gắt. 

Overlay: Ở chế độ này thường nghiêng về sắc độ nóng và rực rỡ. 

Soft Light: Hiệu ứng gần giống hiệu ứng Overlay nhưng độ tương 

phản bị giảm đi, ảnh thường cho ánh sáng dịu. 

Hard Light: Kết quả nghiêng về màu đậm. 

Vivid Light: Tạo ảnh có độ rực rỡ làm tăng độ tương phản so với ảnh ban đầu. 

Linear Light: Gần giống với hiệu ứng Vivid Light nhưng giảm độ tương phản. 

Pin Light: Tạo kết quả rực rỡ màu tuy nhiên có tăng thêm các cấp độ trung gian. 

Difference: Kết quả tạo ra một màu thứ ba khác biệt so với hệ màu ban đầu. 

Exclusion: Gần giống hiệu ứng Difference nhưng bị giảm độ tương phản. 

Hue: Màu sắc bị hòa trộn và lẫn vào màu nền. Ở chế độ này thường có tông màu xám. 

Saturation: Kết hợp độ xám và sắc độ của màu hòa trộn với màu nền. 

Color: Hòa trộn có bảo lưu độ sáng tối của màu nền với sắc độ và cường độ của màu hòa trộn. 

Luminosity: Nghiêng về thang độ xám nhưng màu rực rỡ ít bị hòa trộn. 
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IV. TRANSFORM 

Vào Menu Edit/Transform: Free transform (Ctrl + T). Biến hình 

tự do (Ngoài ra, ta có thể kết hợp bằng cách bấm phím Ctrl và đặt 

trỏ ở các góc để biến dạng, skew,…) 

Scale: Phóng to thu nhỏ đối tượng được chọn 

Rotate: Xoay đối tượng 

Skew: Kéo xiên đối tượng 

Distort: Biến dạng đối tượng 

Perspective: Biến dạng đối tượng theo phối cảnh 

Warp: Biến dạng đối tượng tự do theo phối cảnh (kể cả các phối 

cảnh có độ cong như áp nhãn cho chiếc hộp,…) bằng cách hiệu 

chỉnh các node và tay nắm (handle). 

Rotate 180o: Xoay đối tượng 180o 

Rotate 90o CW: Xoay đối tượng 90o theo chiều kim đồng hồ 

Rotate 90o CCW: Xoay đối tượng 90o ngược chiều kim đồng hồ 

Flip Horizontal: Lật đối tượng theo chiều ngang 

Flip Vertical: Lật đối tượng theo chiều dọc 
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V. LAYER STYLE 

Layer Style là một tính năng mạnh mẽ cho phép bạn áp dụng các hiệu ứng đặc biệt và điều 

chỉnh nhanh chóng cho một layer cụ thể. "Layer Style" giúp tăng tính sáng tạo và thêm chiều sâu 

cho các phần tử trong hình ảnh hoặc thiết kế của bạn. 

Các "Layer Styles" giúp bạn tạo ra các hiệu ứng phức tạp mà không cần phải tạo các layer mới 

hay thực hiện các bước phức tạp. Chúng là công cụ quan trọng trong quá trình chỉnh sửa và thiết 

kế hình ảnh trong Photoshop. 

Stroke (Viền): Thêm một đường viền xung quanh rìa của layer. 

Inner Shadow (Bóng Đổ Bên Trong): Tương tự như Drop Shadow, nhưng tạo ra bóng đổ ở phía 

bên trong layer. 

Inner Glow (Tia Sáng Bên Trong): Tương tự như Outer Glow, nhưng tạo ra sáng ở phía bên 

trong rìa của layer. 

Color Overlay (Chồng Màu): Thêm một lớp màu phủ lên layer, giúp thay đổi màu sắc một cách 

nhanh chóng. 

Gradient Overlay (Chồng Gradient): Áp dụng một gradient màu sắc lên layer. 

Outer Glow (Tia Sáng Ngoại Vi): Tạo ra một vùng sáng xung quanh rìa của layer. 

Drop Shadow (Bóng Đổ): Tạo ra một bóng đổ dưới layer, giúp tạo ấn tượng chiều sâu và nổi bật. 
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CHƯƠNG 5: CÁC CÔNG CỤ CHỈNH SỬA ẢNH CƠ BẢN 

A. Mục đich nghiên cứu 

 
B. Nội dung bài học 

 

I. Di chuyển hình ảnh / đối tượng (Move tool) 

Là công cụ chọn và di chuyển đối tượng. 

Auto Select: Tự chọn Layer hoặc Group 

Show Bounding Box: Hiển thị tám nốt xung quanh đối tượng, ta có thể xoay, co giãn,… 

Nhóm Align: Dùng để gióng hàng các Layer được liên kết (link) với nhau. 

Nhóm Distribute: Dùng để phân phối đều các đối tượng được liên kết với nhau. 

II. Cắt hình (crop tool) 

Là công cụ cắt xén hình ảnh. 

Khi tạo khung viền chọn, ta sẽ thấy trên khung viền có tám nốt vuông (bốn nốt vuông nằm ở 

bốn góc và bốn nốt vuông nằm ở trung điểm của các cạnh). Ta được quyền phóng to để thu hẹp 

khung viền bằng cách kích và rê các nốt vuông. Ngoài ra còn có thể xoay khung viền bằng cách 

đưa con trỏ ra ngoài góc đường viền và rê chuột. Nếu muốn di chuyển khung viền chọn, ta chỉ cần 

đưa trỏ vào bên trong khung viền và rê sang vị trí khác, cuối cùng, nhấn Enter hoàn tất phần xén 

ảnh.  

III. Xóa đối tượng (erase tool) 

Eraser Tool là công cụ cắt vùng thô trong Photoshop. 

Cơ chế hoạt động của công cụ này giống như một cục tẩy giúp bạn xóa đi những chi tiết thừa 

trong ấn phẩm thiết kế của mình.  

  

• Nắm được các công cụ chỉnh sửa ảnh cơ bản 

• Di chuyển hình ảnh / đối tượng (Move tool) 

• Cắt hình (crop tool) 

• Xóa đối tượng (erase tool) 
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CHƯƠNG 6: LÀM VIỆC VỚI PATH – SHAPE 

A. Mục đich nghiên cứu 

 
B. Nội dung bài học 

 

I. Path 

1. Công cụ pen  

Đây là công cụ dùng để vẽ 1 đường Path, Subpath xung quanh hình ảnh nào đó với độ chính 

xác cao (vùng hình ảnh cần tạo vùng chọn). Path, Subpath có hình dạng bất kỳ, tất cả được gọi 

chung là đường Path. 

Path, Subpath là các đối tượng vector, không chứa điểm ảnh. Không được tô màu nên khi in ta sẽ 

không nhìn thấy đường Path. 

Path, Subpath có tính chất trôi nổi, không thuộc về bất kỳ layer nào. 

Pen Tool: công cụ chính để tạo đường Path. 

Freeform Pen Tool: Vẽ đường Path bằng cách rê chuột tự do. 

Add Anchor Point Tool: Thêm node 

Delete Anchor Point Tool: Xoá node 

Convert Point Tool: Hiệu chỉnh tay nắm, biến node gãy nhọn 

thành node trơn, mịn 

Cách vẽ đường Path: 

Chọn công cụ Pen trên thanh công cụ, chọn chế độ Path trên thanh Options. 

Click chuột để tạo điểm neo góc hoặc đoạn thẳng. 

Nhấn giữ và kéo rê chuột để tạo đường cong hoặc điểm neo trơn. Điểm neo trơn sẽ có thêm 2 

đường điều khiển và 2 điểm điều khiển. Đoạn cong có độ lớn và hình dạng như thế nào phụ thuộc 

vào 2 yếu tố này. 

2. Thêm bớt các điểm neo 

Thêm điểm neo: 

Chọn công cụ Add Anchor Point, Click vào đoạn path tại vị trí muốn thêm. 

Chọn công cụ Pen (với tùy chọn Auto add/ Delete được chọn trên thanh Option), Click vào đoạn 

path tại vị trí muốn thêm. 

Bớt điểm neo: 

Chọn công cụ Delete Anchor Point, Click vào điểm neo tại vị trí muốn bỏ. 

Chọn công cụ Pen (với tùy chọn Auto Add/ Delete được chọn trên thanh Option), Click vào điểm 

neo tại vị trí muốn bỏ. 

Tính chất của điểm neo hoặc đường Path 

• Nắm được khái niệm, cách tạo Path, Shape 

• Path 

• Shape 
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Chuyển từ điểm neo trơn thành điểm neo góc. Đồng thời đoạn cong thành đoạn thẳng: Chọn công 

cụ Convert Point rồi click chọn vào điểm neo trơn. 

Chuyển từ điểm neo trơn thành điểm neo góc nhưng đoạn cong không đổi: Chọn công cụ Convert 

Point rồi nhấn giữ và kéo rê điểm điều khiển. 

Chuyển từ điểm neo góc thành điểm neo trơn và đoạn thẳng thành đoạn cong: Chọn công cụ 

Convert Point rồi nhấn giữ và kéo rê tại điểm neo. 

Chuyển từ điểm neo góc thành điểm neo góc và đoạn cong không đổi: Chọn công cụ Convert point 

rồi nhấn giữ và kéo rê tại điểm neo. 

II. Shape 

1. Công cụ Shape 

Rectangle Tool: Vẽ shape hình chữ nhật 

Elipse Tool: Vẽ shape hình elips 

Triangle: Vẽ shape hình tam giác 

Polygon Tool: Vẽ shape hình đa giác 

Line Tool: Vẽ shape dạng đường line 

Custom Shape Tool: Vẽ shape hình tùy chỉnh 

• Giữ Shift để vẽ hình cân đối. 

• Giữ Alt để vẽ từ tâm ra. 

• Giữ Shift + Alt để vẽ hình cân đối từ tâm ra. 

• Giữ Space bar để di chuyển Shape trong khi đang vẽ. 

Các tùy chỉnh trên thanh Option.  

Pick tool mode: chọn path hoặc shape để vẽ. 

Fill: đổ màu vào trong shape. 

Stroke: đổ màu viền cho shape. 

Stroke type: loại nét của đường viền. 

W& H: nhập kích thước cố định của shape muốn vẽ. 

Path Operations: Dùng để kết hợp các Shape. Có những chức năng: vẽ Shape mới, vẽ cộng vào 

Shape cũ; Vẽ loại trừ Shape cũ, lấy vùng giao giữa 2 Shape. Và đục thủng vùng giao giữa 2 Shape. 

Path alignment: So hàng các shape với nhau hoặc với artboard. 

Path arrangement: sắp xếp vị trí các shape trên cùng một layer. 

2. Properties panel 

Mở bảng Properties bằng cách vào menu Window → properties. 

Transform: Hiển thị vị trí, kích thước shape 

Appearance: Điều chỉnh màu, viền,… 

T

in Học Sao Việt 093 11 44 85 8



Trung Tâm Tin Học Sao Việt   093.11.44.858  tinhocsaoviet.com 

 Đào Huy Hoàng Giáo Trình Photoshop Cơ Bản | Trang 21 

Pathfidenr: Kết hợp shape 
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CHƯƠNG 7: LÀM VIỆC VỚI CHỮ 

A. Mục đich nghiên cứu 

 
B. Nội dung bài học 

 

I. Công cụ Type (tạo văn bản) 

Horizontal Type Tool: Công cụ tạo văn bản ngang 

Vertical Type Tool: Công cụ tạo văn bản dọc 

Horizontal Type Mask Tool: Công cụ tạo văn bản ngang với 

hình thức là vùng chọn 

Vertical Type Mask Tool: Công cụ tạo văn bản dọc với hình thức là vùng chọn 

II. Character Palette (định dạng ký tự) 

Leading: Khoảng cách dòng 

Kerning: Khoảng cách giữa hai ký tự 

Tracking: Khoảng cách giữa các ký tự 

Vertically Scale: Co giãn văn bản theo chiều dọc 

Horizontally Scale: Co giãn văn bản theo chiều ngang 

Set the baseline Shift: Khoảng cách với đường nền ban đầu… 

III. Paragraph Palette (địng dạng đoạn) 

Left align text: Canh trái văn bản. 

Center text: Canh giữa văn bản. 

Right align tet: Canh phải văn bản. 

Justify last left: Canh thẳng hàng hai bên, trừ dòng 

cuối cùng canh trái. 

Justify last centered: Canh thẳng hàng hai bên, trừ 

dòng cuối canh giữa. 

Justify last right: Canh thẳng hàng hai bên, trừ dòng 

cuối canh phải. 

Justify all: Canh thẳng hàng hai bên bắt buộc, kể cả 

dòng cuối cùng. 

• Nắm được cách tạo chữ và hiệu chỉnh chữ 

• Công cụ Type (tạo văn bản) 

• Character Palette (định dạng ký tự) 

• Paragraph Palette (địng dạng đoạn) 

• Uốn cong văn bản  
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VI. Uốn cong văn bản  

Chọn Style kiểu uốn cong 

Chọn Blend định mức độ uốn chữ 

Horizontal Distortion và Vertical Distortion: 

áp dụng phối cảnh cho chữ 

Ngoài ra, ta còn có thể uốn cong Text bằng 

cách cho text chạy theo đường path 

Thao tác: 

Tạo đường path 

Chọn công cụ Text đặt gần đường Path kích 

một lần lên đường path 

Nhập Text khi có dấu nhắc xuất hiện. 

Chúng ta có thể hiệu chỉnh text trên đường Path bằng công cụ Direct selection tool 
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CHƯƠNG 8: CỌ VẼ VÀ ĐỔ MÀU 

A. Mục đich nghiên cứu 

 
B. Nội dung bài học 

 

I. Làm việc với bảng màu 

1. Làm việc với Bảng Swatches palette 

Swatches Palette là nơi chứa các mẫu màu, mặc định là 128 màu 

nhưng ta có thể thêm hoặc bớt những màu trên đó. Mở đóng 

Swatches Palette: Vào menu Window/ Swatches 

Create New Swatch: Tạo mẫu màu mới vào hộp thoại swatches. 

Delete Swatch: Xóa mẫu màu 

Khi click chọn mẫu màu, màu sẽ xuất hiện ở ô foreground. 

 

 

2. Làm việc với Bảng Color palette  

3. Chọn lựa màu Foreground, Background 

Quan sát trên hộp công cụ ta sẽ thấy có biểu tượng hai ô màu, ô nằm trên là ô màu 

Foreground (tiền cảnh) và ô nằm dưới là ô màu Background (hậu cảnh).  

 

Foreground: màu tiền cảnh 

Switch foreground to background colors: hoán đổi giữa màu tiền cảnh và màu nền (X) 

Background: màu nền 

Default color: tái lập mặc định màu đen trắng (D) 

Tô màu cho vùng chọn bằng màu Foreground: nhấn phím Alt+Delete. 

Tô màu cho vùng chọn bằng màu Background: nhấn phím Ctrl+Delete. 

• Nắm được cách tạo lấy màu, đổ màu, cọ vẽ 

• Làm việc với bảng màu 

• Công cụ hút màu (Eyedropper) 

• Công cụ đổ màu 

• Cọ vẽ (Brush) 
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II. Công cụ hút màu (Eyedropper)  

Công cụ dùng để lấy màu mặt (Foreground) hoặc màu nền 

(Background) trên hình ảnh. 

III. Công cụ đổ màu 

1. Paint Bucket Tool 

Dùng để tô đầy một màu đồng nhất hoặc một mẫu họa tiết (Pattern) 

vào những Pixel liền kề có giá trị màu tương tự với pixel vừa nhấp.  

2. Gradient Tool 

Dùng để tô màu chuyển sắc 

 

Linear Gradient: Màu biến thiên từ điểm đầu đến điểm cuối theo đường thẳng.  

Radial Gradient: Màu biến thiên từ điểm đầu đến điểm cuối theo dạng tỏa tròn. 

Angle Gradient: Màu biến thiên nghịch chiều kim đồng hồ xung quanh điểm bắt đầu (giống hình 

chóp hay hình nón). 

Reflected Gradient: Màu biến thiên dựa trên mẫu gradient tuyến tính đối xứng ở một bên điểm 

bắt đầu. 

Diamond Gradient: Màu biến thiên từ điểm bắt đầu hướng ra ngoài theo dạng hình thoi. Điểm 

cuối quyết định một góc của hình thoi. 

Bảng Gradient Editor 
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IV. Cọ vẽ (Brush) 

Brush là công cụ tô vẽ bằng màu Foreground với nét cọ tùy chọn  

 

Brush: Nơi chứa các loại cọ và kiểu cọ khác nhau (thư viện nét cọ) 

Mode: Các chế độ hoà trộn của cọ Brush 

Opacity: Độ trong suốt màu của cọ vẽ 

Flow: Áp lực phun màu của công cụ (giá trị càng lớn màu phun ra càng nhiều – Chỉ có tác dụng 

khi chọn công cụ AirBrush trên thanh Options). 

Muốn vẽ đoạn thẳng: Kích xác định điểm thứ nhất, nhả chuột, bấm giữ Shift và tiếp tục kích xác 

định điểm thứ hai.  

 

Một số nét cọ Brush tiêu biểu:  

Hộp thoại Brush  
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CHƯƠNG 9: HIỆU CHỈNH ÁNH SÁNG VÀ MÀU SẮC 

A. Mục đich nghiên cứu 

 
B. Nội dung bài học 

 

I. Hiệu chỉnh sáng tối 

1. Levels 

Dùng để chỉnh sửa khoảng tông và độ cân bằng màu của hình ảnh bằng cách điều chỉnh các mức 

cường độ của vùng tối, vùng giữa tông và vùng sáng trong ảnh. 

2. Curves 

Hiệu chỉnh đồng bộ các mức sáng – tối – trung bình.  

3. Brightness/Contrast 

• Nắm được cách hiệu chỉnh ánh sáng và màu sắc 

• Hiệu chỉnh sáng tối 

• Hiệu chỉnh màu cơ bản 
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Hiệu chỉnh sắc độ sáng tối và cường độ tương phản trong hình ảnh.  

Thao tác thực hiện: Chọn lệnh Brightness/ 

Contrast. Di chuyển con trượt của thanh 

Brightness, nếu sang bên trái làm tối hình ảnh. 

Ngược lại, sang bên phải làm sáng hình ảnh. Di 

chuyển con trượt của thanh Contrast, nếu sang 

trái là giảm độ tương phản. Ngược lại, sang bên 

phải sẽ làm tăng độ tương phản trong hình ảnh. 

Tùy chọn “Use Legacy”: Sử dụng tính kế thừa 

kết quả trước đó của hiệu ứng. 

Kích nút OK. 

II. Hiệu chỉnh màu cơ bản 

1. Vibrance 

Dùng để điều chỉnh sự sống động của màu sắc trong ảnh mà không làm mất thông tin chi tiết hay 

gây ra hiện tượng quá sáng  

Sau khi chọn Vibrance, một hộp thoại sẽ xuất 

hiện. Bạn có thể sử dụng thanh trượt hoặc 

nhập giá trị trực tiếp để điều chỉnh mức 

Vibrance theo ý muốn. 

 

 

 

2. Hue/Saturation 

Dùng để hiệu chỉnh sắc độ, độ 

bão hòa màu và mức độ sáng 

tối cho hình ảnh. 

Thao tác thực hiện: Di chuyển 

các thanh trượt trong bảng 

Hue/Saturation 

Hue: hiệu chỉnh tông màu 

Saturation: hiệu chỉnh sắc độ 

(độ bão hòa) 

Lightness: hiệu chỉnh độ sáng 

tối. 

 

3. Color Balance 

Dùng để cân bằng màu sắc. 

Thao tác: Rê các thanh trượt để cân bằng màu 

Cyan: màu xanh da trời 

T
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Red: màu đỏ 

Magenta: màu tím sen 

Green: màu xanh lục 

Yellow: màu vàng 

Blue: màu xanh dương. 

Shadows: Tập trung thay đổi những 

vùng hình ảnh có sắc độ tối. 

Midtones: Tập trung thay đổi những 

vùng hình ảnh có sắc độ trung bình 

Highlights: Tập trung thay đổi những vùng hình ảnh có sắc độ sáng. 

Preserve Luminosity: tùy chọn này cho phép duy trì độ sáng trong hình ảnh. 

4. Invert 

Nghịch đảo màu  
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CHƯƠNG 10: XUẤT FILE 

A. Mục đich nghiên cứu 

 
B. Nội dung bài học 

 

I. Các thông số cần nắm 

Trước khi tiến hành xuất file photoshop in, bạn cần biết rõ về các thông số để thao tác nhanh 

chóng, chính xác. Chức năng Export trong Photoshop dùng để xuất file thiết kế của bạn ra các định 

dạng. Trong đó, 2 định dạng được sử dụng phổ biến là định dạng ảnh jpg và png. 

Để xuất file ra chất lượng, bạn cần thiết lập các thông số một cách phù hợp. Các thông số cần 

quan tâm bao gồm: 

Color Model: Hộp tùy chọn hệ màu cho file ảnh. Trong đó, EGB là hệ màu dufnng cho các thiết 

bị số, CMYK là hệ màu in ấn, Grayscale là hệ màu đen – trắng (dùng in đen trắng là chủ yếu). 

Quality: Chất lượng ảnh/bản in. Thông thường sẽ có 4 cấp độ: Low (thấp), Medium (trung bình), 

High (cao), Maximum (cao nhất). Bình thường mọi người sẽ để chất lượng Maximum để có chất 

lượng tốt nhất. 

Compress method: Phương án nén file, mục đích để chọn chế độ nén dung lượng file in ấn. Có 2 

chế độ bao gồm: Standard (tiêu chuẩn) và Optimize (tối ưu). 

 Resolution: Độ phân giải của bản in ảnh. Trong đó, bạn sẽ cần quan tâm tới 4 mức độ: 

+ Screen (72 ppi): Dùng để xuất ảnh cho thiết bị kỹ thuật số (màn hình máy tính, gửi mail hay 

đăng Facebook,…). 

+ Medium (150 ppi): Dùng cho trường hợp muốn nhìn rõ chữ trên màn hình. Chế độ này được 

dùng khi in ấn nếu file thiết kế có kích thước lớn hơn ½ đổ lên.  Ví dụ, bạn xuất file là A4 nhưng 

chỉ in khổ A5 thì nên chọn Medium. 

+ High (300dpi): Dành cho trường hợp xuất ảnh đi in ấn trong trường hợp file thiết kế & file 

in có tỷ lệ bằng nhau. Tuy nhiên, hãy lưu ý độ phân giải 300 ppi vẫn chưa phải độ phân giải để in 

ra một file có độ nét cao nhất. 

+ Other: Nếu bạn muốn nhập con số khác thì có thể dùng chế đọ này. Độ phân giải giới hạn 

lên tới 450 ppi, thường dùng cho các filt in phun hoặc lazer màu. 

• Hiểu về các thông số khi xuất file 

• Biết cách xuất file với nhiều định dạng khác nhau 

 

• Các thông số cần nắm 

• Xuất file hình ảnh 

• Xuất file cho web  

• Xuất file Pdf 
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II. Xuất file hình ảnh 

Trong thanh menu, chọn File → Export → Export As. 

Trong hộp thoại "Export As," bạn có thể chọn định dạng xuất ảnh, ví dụ: JPEG, PNG, GIF, hoặc 

nhiều định dạng khác. 

Chọn định dạng tùy thuộc vào mục đích sử dụng (chẳng hạn, JPEG cho hình ảnh chất lượng cao, 

PNG cho ảnh có độ trong suốt).  

Trong cùng hộp thoại, bạn có thể điều chỉnh các cài đặt như kích thước ảnh, chất lượng, mức độ 

nén, và các tùy chọn khác tùy thuộc vào định dạng bạn chọn. 
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III. Xuất file cho web  

Trong thanh menu, chọn File → Export → Save for Web (Legacy). 

Trong hộp thoại "Save for Web," bạn có thể chọn định dạng xuất, ví dụ: JPEG, PNG, GIF. 

Chọn định dạng tùy thuộc vào mục đích sử dụng (chẳng hạn, JPEG cho hình ảnh chất lượng cao, 

PNG cho ảnh có độ trong suốt).  
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Trong cùng hộp thoại, bạn có thể điều chỉnh các cài đặt như kích thước ảnh, chất lượng, mức độ 

nén, và các tùy chọn khác tùy thuộc vào định dạng bạn chọn. 

IV. Xuất file Pdf 

Trong thanh menu, chọn File → Save As. 

 

Chọn định dạng "Photoshop PDF." 
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Trong cùng hộp thoại, bạn có thể điều chỉnh các cài đặt như kích thước ảnh, chất lượng, mức độ 

nén, và các tùy chọn khác. 

 

CHƯƠNG 11: BÀI THI KẾT THÚC KHÓA HỌC PHOTOSHOP CƠ BẢN 


